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Руководству Pixel Perfect Precision уже четыре года. По 

прошествии этого времени мы переключили внимание с 

пикселей как таковых и решили больше рассказать о том как мы 

работаем — новая глава о Дизайне и Разработке как раз об 

этом. Хотя наше портфолио невероятно разнообразно: от 

приложений мобильного банкинга до пазлов, ломающих законы 

физики, мы всегда применяем одинаковые принципы дизайна о 

которых мы и поговорим. Наслаждайтесь!

Фото продукта: Monument Valley

ИНТРО
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http://www.monumentvalleygame.com
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СПАСИБО
Есть несколько людей, которые заслуживают упоминания. В 

первую очередь Широ, за то что все эти годы показывал мне 

истинное значение точности пикселя. Все дизайнеры которые 

ежедневно делились знаниями — вы отличный источник как 

вдохновления так и информациии. Больше всего я хочу 

поблагодарить всех моих друзей в ustwo за их бесконечную 

поддержку в создании этого руководства.

Фото продукта: Rando
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http://rando.ustwo.se
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Первый раздел рассказывает о принципах и темах которые 

касаются digital дизайна и его важных инструментах. Пригодные 

как для профессионалов так и новичков в области, эти советы — 

своеобразное руководство по быстрому пониманию процессов 

и мыслей которые мы используем в ustwo.

ОСНОВЫ
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ПРИНЦИПЫ
PIXEL PERFECT 



Юзеры Пользователи — главный объект вашего 

внимания. Определите что им нужно, 

используйте это в дизайне, а затем 

сформируйте ваш продукт так, чтобы 

пользователи могли выполнить действие 

как можно быстрее. Не забывайте о том что 

им подходит. Flat интерфейс основанный на 

правилах типографики и сетки подойдет 

аудтории помоложе, а более дружелюбные 

сквеморфические элементы подойдут для 

возрастных юзеров которые не на столько 

продвинуты.
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Окружение Окружение — это не только платформа для 

который вы делаете дизайн, но также 

условия использования и место в котором 

он будет работать. К примеру, мобильный 

телефон существенно отличается от 

телевизора — на него смотрят издалека, он 

всегда используется в помещении и 

управляется удалённо. Это подразумевает 

другие подходы к размеру текста, цвету и 

контрастности интерфейса.
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Доступность Доступноcть касается всех, а не только 

пользователей с ограниченными 

возможностями. Следить за простотой и 

доходчивостью это хорошая практика, но 

есть и другие шаги, которые вы можете 

предпринять чтобы сделать вашу работу 

более доступной для дальтоников и людей 

неспособных к чтению. Смотрите главу 

Доступность для большей информации.

Плохо Хорошо
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Случайный 
сдавленный текст 
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Худшие сценарии Этот принцип связан с доступностью: 

убедитесь в том что ваш продукт не 

сломается в реальной ситуации с 

реальными юзерами. Мы все любим 

использовать красивые иллюстрации и 

текст, клиенты тоже это любят.  Важно 

проверять дизайн с более длинным текстом, 

другим языком, отсутствием или большим 

разнообразием картинок и т.д. Вы можете 

показывать «красивую» версию, но иметь 

несколько вариантов исходников для 

проверки.

Длинный загол...

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание
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Einen wirklich la…
Das gleiche auch…

Средний 
Как бы OK

A
B

Длинный очень
И тут тоже очень

?

Лучший Худший

Длинный загол...



Возможности Под возможностью мы подразумеваем 

способность объекта выражать свои 

функции через органы чувств: кнопка своей 

выпуклостью подразумевает нажатие, 

дверная ручка, благодаря форме и 

расположению намекает на то, что ее можно 

потянуть. Все это можно использовать в 

digital дизайне, чтобы заставить 

пользователей взаимодействовать с 

объектами. Выпуклые кнопки, текст который 

заходит за границы страницы (намекая на 

скрол) — это демонстрация возможностей.
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Lorem ipsum dolor sit amet, 
consectetur adipisicing elit, 
sed do eiusmod tempor 
incididunt ut labore et dolore 
magna aliqua. Ut enim ad 
minim veniam, quis nostrud 
exercitation ulamco laboris nisi 
ut aliquip ex ea commodo 
consequat. Duis aute irure 
dolor in reprehenderit in 
voluptate velit esse cillum 
dolore eu fugiat nulla pariatur. 
Excepteur sint occaecat 
cupidatat non proident, sunt in 



Текст То что вы говорите в дизайне также важно 

как и его внешний вид. Хороший текст не 

только делает приложение понятнее, но и 

создает связь с пользователем, благодаря 

используемому тону. Когда вы говорите с 

людьми на родном языке, а не как с 

машиной, создается эмоциональная связь, 

которая улучшает опыт взаимодействия с 

продуктом.

Плохо Хорошо
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Обработка Привет

Привет, Мэтт!

Так как ты запустил 

программу в первый раз, мы 

хотим задать несколько 

вопросов, чтобы все прошло 

как по маслу, это займет 

несколько минут. Нажимай 

на кнопку ниже и вперед!

Требования

Мы определили что вы 

запустили приложение 

первый раз. Перед тем как 

начать вам нужно ответить на 

серию вопросов, для 

удостоверения того что все 

настроено корректно.

Начало Хорошо



Форма и цвет У некоторых цветов и форм есть 

устоявшиеся ассоциации в digital дизайне. 

Не забывайте про это, так как их 

несоблюдение может сбить юзера с толку. 

Зеленые галочки ассоциируются с хорошим, 

а красный цвет и крестики — с плохим. 

Смешивая их, мы создаем смешанное 

сообщение. Так же желтый треугольник 

обычно ассоциируется с предупреждением, 

а синий круг с информацией.

ii

!!

Плохо
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Хорошо



Визуальная 
иерархия

Разметка, цвет, типографика очень сильно 

влияют на визуальное восприятие и 

потребление информации. Подумайте о том, 

что вы хотите показать пользователю и в 

каком порядке, затем руководствуйтесь 

этим в дизайне. Привлекайте внимание с 

помощью контрастных, больших и жирных 

шрифтов, или наоборот, используйте менее 

контрастный, мелкий, легкий шрифт для 

менее важных элементов. Не забывайте о 

культурных аспектах вашей аудитории.

Плохо Хорошо
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Типографика В digital дизайне типографику часто 

незаслуженно обделяют вниманием. Очень 

важно использование хорошей 

типографики, ведь большинство 

информации передается в виде текста. 

Существуют базовые факторы на которые 

нужно обращать внимание. Комфортно ли 

читается текст при текущем размере, 

достаточен ли интерлиньяж, длинна строки? 

Не пользуйтесь стандартными настройками 

шрифта вашей среды дизайна. Уважайте 

шрифт — он это заслужил.

Плохо Хорошо
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Lorem ipsum dolor sit amet, consectetur 
adipisicing elit, sed do eiusmod tempor 
incididunt ut labore et dolore magna aliqua. 
Ut enim ad minim veniam, quis nostrud 
exercitation ulamco laboris nisi ut aliquip ex 
ea commodo consequat. Duis aute irure 
dolor in reprehenderit in voluptate velit esse 
cillum dolore eu fugiat nulla pariatur. 
Excepteur sint occaecat cupidatat non 
proident, sunt in culpa qui officia deserunt 
mollit anim id est laborum. Lorem ipsum dolor 
sit amet, consectetur adipisicing elit, sed do 
eiusmod tempor incididunt ut labore et 
dolore magna aliqua. Ut enim ad minim 
veniam, quis nostrud exercitation ulamco 
laboris nisi ut aliquip ex ea commodo 
consequat. Duis aute irure dolor in 
reprehenderit in voluptate velit esse cillum 
dolore eu fugiat nulla pariatur. Excepteur sint 
occaecat cupidatat non proident, sunt in 
culpa qui officia deserunt mollit anim id est 
laborum. Lorem ipsum dolor sit amet, 
consectetur adipisicing elit, sed do eiusmod 
tempor incididunt ut labore.

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et dolore 

magna aliqua. Ut enim ad 

minim veniam, quis nostrud 

exercitation ulamco laboris nisi 

ut aliquip ex ea commodo 

consequat. Duis aute irure 

dolor in reprehenderit in 

voluptate velit esse cillum 



Движение С постоянным увеличением мощности 

компьютеров, мы можем делать не только 

красивый дизайн, но и добавлять в него 

элегантную динамику. Легкая анимация 

может задать характер интерфейса, 

улучшить его интуитивность, выделить 

функции и возможности. К примеру, если вы 

хотите привлечь внимание к кнопке — 

заставьте ее пульсировать.

Вход Выход
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Объект
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Объект
Описание

Объект
Описание



Тестирование Ничто не сравниться с тестом дизайна на  

предназначенном устройстве. Разрешение, 

технология экрана, углы просмотра и 

методы ввода могут существенно 

отличаться от вашего компьютера. В наше 

время существует множество средств для 

предварительного просмотра, которые 

перенесут дизайн с компьютера прямо на 

ваш девайс, обновляясь в реальном 

времени. Обязательно пользуйтесь ими!
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Прототипы Тестирование очень тесно связано с 

прототипированием. Прототипы позволяют 

нам быстро опробовать идеи, не тратя 

времени на финальную «полировку». 

Начиная от набросков на бумаге, 

заканчивая созданием простых приложений 

в нативной среде разработки. Все зависит 

от того что вам нужно: наброски можно 

сделать и на бумаге, а вот с плавную 

анимацию придется показать на видео.
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Демо

Неактивно
Ничего не делаю

Неактивно
Ничего не делаю

Неактивно
Ничего не делаю

Нажми меня
Я работаю

Набросок

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Фильм

Статика
А я не двигаюсь

Статика
А я не двигаюсь

Статика
А я не двигаюсь

Смотри!
Я буду двигаться!

Movie.avi



Организация Один в поле не воин, и в большинстве 

случаев это также касается файлов. 

Хорошая организация необходима, так как 

она сохраняет уйму времени другим людям, 

которые работают над проектом. 

Правильный порядок файлов и слоев дает 

другим дизайнерам возможность сразу 

взяться за вашу работу и найти все 

необходимое, а логически правильные 

имена файлов порадуют разработчиков.

Rectangle.png

Square Blue.png

Square Green.png

Square Orange.png

Square Pink.png

Assets

Screen.psd

Design

Project
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Сделайте 
перерыв

Очень просто полностью погрузиться в 

дизайн, но иногда стоит сделать перерыв. 

Это полезно для здоровья и позволяет 

взглянуть на работу с другой стороны. 

Прогуляйтесь, заварите себе кофе. По 

возврату решение возможных проблем 

будет у вас как на ладони, либо вы заметите 

ошибку, которую до этого не замечали.
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ДЕТАЛИ PIXEL 
PERFECT



Острые грани Прямые углы должны быть без 

полупикселей: резкими и никакого 

размытия.

Плохо Хорошо
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Выравнивание
и расстояния

Как только вы научитесь делать все резким, 

следующим шагом на пути к pixel perfect 

будет уверенность в том что все расстояния 

и выравнивания верны.
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Плохо Хорошо



Связность Выравнивание объектов на всех макетах 

очень важно. Расположение 

повторяющихся заголовков, футера, кнопки 

возврата должно быть идентичным, не 

должно быть «прыжков». Помочь в этом 

может сетка, которая определит структуру 

на всех макетах.
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Цветовая модель HSB навсегда! Попробуйте использовать 

цветовую модель HSB, и вы сразу увидите 

насколько это эффективный вариант для 

создания оттенков базового цвета. В 

данном примере значение оттенка (H) 

остается неизменным, а насыщенность (S) и 

яркость (B) меняются. Посмотрите насколько 

цифры в HSB более информативны по 

сравнению с RGB.

100%

100%

0%

0%

Red 230 249 242 116

Green 12 194 133 6

Blue 41 201 148 20

Hue 352 352 352 352

Saturation 95 22 45 95

Brightness 90 98 95 45
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0°

180°

300° 60°

240° 120°

B

S

H



Управление 
цветом

Управление цветом играет большую роль в 

полиграфии. В digital оно чаще создает 

проблемы, чем решает их. В процессе 

разработки тяжело контролировать цвет (в 

отличии от дизайна), особенно когда он 

смешивается с кодом, указывающим те же 

исходные цвета. Может возникнуть 

несоответствие. Лучше проигнорировать эту 

процедуру, и проверить на устройстве — в 

отличие от печати это быстро и ничего не 

стоит.

Цветовой профиль

Код

Да Нет

Плохо Хорошо
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Высота и ширина 
текста

Эти два метода помогут справится с 

динамическим контентом. Чтобы узнать 

максимальную высоту используйте Åy 

комбинацию; точно также, если вы хотите 

узнать ширину для определенного контента 

заполните этот промежуток набором 

прописных W — если они поместятся, то и 

другие фразы тоже. 

Åy
Макс. Высота

WWW
Макс. Ширина
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Длина текста Если вы работает над продуктом, который 

будет использоваться по всему миру, то 

обращайте внимание на длину контента на 

других языках. Пример показывает нам, что 

происходит с русским и португальским 

переводом слова Settings, длина 

увеличивается до 75%.

Settings
Настройки
Configurações
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Выравнивание 
текста на кнопках

Вверху показаны три метода вертикального 

выравнивания текста на кнопках. Какой 

метод лучше — зависит от гарнитуры 

шрифта (соотношение высоты заглавной 

буквы к x-высоте может меняться) и 

регистра, который вы используете. Как 

только вы выбрали правило следуйте ему в 

интерфейсе — последовательность решает 

все.

Заглавная и подстрочный х-высота Заглавная и x-высота
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Выравнивание 
текста с объектом

Для вертикального выравнивания текста с 

объектом лучше использовать x-высоту, чем 

высоту заглавной буквы, так как это 

визуально смотрится лучше. В плохом 

примере выше вы видите, что основная 

визуальная высота шрифта, расположенная 

в зоне x-высоты находится ниже чем 

квадрат. Исключением будет текст в 

котором только прописные или цифры — 

они могут быть выровнены по заглавным, 

так как у них нет подстрочных символов.

Align Text Align Text

Плохо Хорошо
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Состояния 
объекта

Интерактивные элементы имеют больше 

чем одно состояние, которое уже показано 

у вас в наброске. Элементы могут меняться 

в зависимости от платформы и метода 

ввода, в любом случае делайте их сразу во 

время создания дизайна. Не оставляйте это 

на потом, так вы будете уверены, что все 

смотрится хорошо и работает 

взаимосвязанно. 

Активен

Выбран

Отключен
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Границы и радиус 
закругления углов

Компонентам интерфейса зачастую нужны 

границы. Прямые углы сделать просто, но 

как быть с внешним радиус закругления 

углов при помощи внутренней обводки? 

Есть варианты: соответствие внутреннего и 

внешнего радиуса, масштабирование 

первоначального шейпа по размеру, 

добавление границы и исходного 

внутреннего радиуса одновременно. 

Последний вариант является лучшим так как  

не утолщает очертание в углах, в отличие от 

других методов.
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Кнопка

Внешний = Внутренний Масшатибрование Внешний = Внутренний + 
ширина границы

Кнопка Кнопка



Границы и радиус 
закругления углов
Filleting

Если вы используете последний вариант с 

предыдущей страницы, но начали с 

внешнего радиуса, в конечном итоге у вас 

получится шейп, углы которого будут 

прямыми. В таких сиутациях 

рассматривается добавление небольшого 

радиуса «назад». Хоть это и математически 

неправильно но выглядит лучше. В 

инженерии этот процесс известен как 

скругление внутренней или внешней части 

дизайна. Посмотрите статью «In search of 
perfect radius» от RA Design.
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Кнопка Кнопка

Внешний = Внутренний − 
Ширина бордера

Filleted

http://radesign.in/in-search-of-the-perfect-radius/
http://radesign.in/in-search-of-the-perfect-radius/
http://radesign.in/in-search-of-the-perfect-radius/
http://radesign.in/in-search-of-the-perfect-radius/


Равносторонние 
треугольники

Некоторые графические редакторы рисуют 

треугольники, которые по-умолчанию не 

являются равносторонними. Такие 

треугольники имеют равную длинну по осям 

x и у. Чтобы быстро сконвертировать такой 

треугольник в равносторонний, возьмите 

86.6% от текущей высоты.

100%

86.6%

100%

100%

Плохо Хорошо
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Контроль версий Хоть сейчас и существует множество 

приложений по контролю версий для 

дизайнеров, чаще всего мы занимаемся 

этим самостоятельно. На это уходит много 

времени, но есть система позволяющая 

упростить процесс. Самый последний файл 

Screen.psd хранится в корне рабочей папки. 

В начале дня, или при дублировании файла, 

старая версия копируется в папку Архив, а 

файл получает имя в формате YYMMDD с 

номером версии. Чистота!

Screen_140401_r01.psd

Архив

Проект

Screen.psd

Screen_140402_r01.psd

Screen_140402_r02.psd

Screen_140402_r03.psd

Screen_140403_r01.psd

Screen_140403_r02.psd

Screen_1.psd

Проект

Screen_2.psd

Screen_FINAL.psd

Screen_FINAL_FINAL.psd

Screen_FINAL_FINAL_2.psd

Screen_FINAL_FINAL_3.psd

Screen_Latest_1.psd
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Screen_Latest_2.psd

Плохо Хорошо



ДОСТУПНОСТЬ



Доступность Доступность это не компромисс, 

подстроенный под людей с ограниченными 

возможностям, а хороший, общедоступный 

дизайн. Для этого не нужно жертвовать 

привлекательностью или тратить время и 

деньги. Как и принцип pixel perfect precision: 

если вы с самого начала встраиваете 

доступность в свой дизайн-процесс, ее 

реализация не займет много времени.

      Если я сделал 
дизайн доступным, не 
будет ли он уродлив?
“
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Виды недостатков Примерно 10% населения нашей планеты 

имеет различные формы инвалидности. Это 

существенная часть потенциальных 

пользователей. На digital проекты влияют: 

зрение, слух, осязание и познание, т.е. 

способность обрабатывать остальные 3 

чувства. Не полагайтесь на одно чувство в 

своих приложениях, предоставляйте 

несколько форм взаимодействия и 

коммуникации, к примеру включайте  

функцию text-to-speech для юзеров у 

которых проблемы со зрением.
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Ясность Дизайн не должен перегружать юзера 

контентом, он должен быть доступным и 

лаконичным. Вы можете показывать контент 

в зависимости от ситуации, начиная со 

значимой информации, раскрывая детали 

по мере необходимости. Также важно 

подгонять контент под мобильные 

устройства, к примеру, иметь миниатюры 

изображений для юзеров с плохим 

качеством связи.

Плохо Хорошо
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Заголовок

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Заголовок

Объект
Описание

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

laboris. nisi ut aliquip ex ea 

Слишком длинный 
заголовок для 

Объект Описание которое выходи за гра

Объект Описание которое выходи за гра

Объект Описание которое выходи за гра

Lorem ipsum dolor sit amet, consectetur 
adipisicing elit, sed do eiusmod tempor 
incididunt ut labore et dolore magna aliqua. Ut 
enim ad minim veniam, quis nostrud 
exercitation ulamco laboris.

Lorem ipsum dolor sit amet, consectetur 
adipisicing elit, sed do eiusmod tempor 
incididunt ut labore et dolore magna aliqua. Ut 
enim ad minim veniam, quis nostrud 
exercitation ulamco laboris.

Lorem ipsum dolor sit amet, consectetur 
adipisicing elit, sed do eiusmod tempor 



Постоянство Дизайн требует постоянства на нескольких 

уровнях: стиль, навигация, типографика и 

использование языка. Элементы 

интерфейса должны вести себя одинаково 

вне зависимости от момента появления, и, 

где это возможно, должны повторять 

поведение стандартных элементов среды 

для которой вы делаете дизайн — так юзер 

может предсказать поведение продукта, 

используя накопленный опыт. Не забудьте 

ознакомиться с гайдлайнами и образцами 

взаимодействия нужного устройства.
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OS

Заголовок
Подзаголовок

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

App

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

App

Объект
Описание

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 



Навигация Как мы уже говорили на предыдущей 

странице, навигация не должна меняться, 

чтобы пользователь не запутался в 

приложении. Располагайте элементы в 

одном месте и в одном стиле на всех 

страницах. Это также касается других частей 

интерфейса: если кнопка выполняет 

определенное действие в одной части 

приложения, она должна делать то же самое 

и в других.
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Заголовок

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Заголовок

Объект
Описание

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

Заголовок

Объект
Описание

Объект
Описание

Объект
Описание

Результаты поиска

Объект



При работе над внешним видом страницы 

задумывайтесь о целях и потребностях 

юзера. Уже на основе этой информации 

располагайте контент, выделяя важные 

части.

 
Структура 
контента

Навигация
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Плохо Хорошо

Заголовок Заголовок

Какая-то важная 
информация

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

laboris nisi ut aliquip ex ea 

commodo consequat. 

Какая-то важная 
информация

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

i

i



Мы не можем  сказать что все шаги на 

одном экране — хорошая идея, но и не стоит 

забывать о том, что большое количество 

шагов путает юзеров. Старайтесь не 

выходить за лимит четырех шагов, иначе 

юзер может заблудиться.

 
Меньше шагов
Навигация
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Привет!

Нажми на 

ссылку ниже 

для инфо...

Инфо

…потом на 

эту ссылку…

…и наконец-

то на эту.

Наконец-то 

мы здесьИнфо Инфо

i

Плохо Хорошо

Намного 

проще!

Привет!

Нажми на 

ссылку внизу 

для инфо…

Инфо

i



Не забывайте про заголовки страниц. 

Пользователь будет знать где находиться и 

воспринимать информацию в правильном 

контексте.

 
Заголовки
Навигация
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Плохо Хорошо

Заголовок

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание



Размер контента должен соответствовать  

размеру страницы, а разрывы должны 

вставляться с умом. Намного проще 

проскролить страницу, чем перейти по 

ссылке. Это также уменьшает количество 

запросов, что важно для юзеров мобильных 

устройств. Но не делайте страницы слишком 

длинными — мало кто любит бесконечный 

скрол. 

 
Соответствующий 
размер страницы 

Навигация
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Плохо Хорошо

Заголовок Заголовок

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

laboris nisi ut aliquip ex ea 

commodo consequat. Duis 

aute irure dolor in. 

reprehenderit in voluptate 

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

Объект
Описание

Объект
Описание



Убедитесь в том что скролл работает только 

в одном направлении — так проще и 

физически и сознательно. Юзерам не нужно 

будет прыгать по странице, пытаясь понять 

что они видели, а что нет.

Одна ось 
прокрутки

Навигация
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Плохо Хорошо

Заголовок

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, sed do 

eiusmod tempor incididunt ut labore et 

dolore magna aliqua. Ut enim ad minim 

veniam, quis nostrud exercitation 

ulamco laboris nisi ut aliquip ex ea 

commodo. consequat. Duis aute irure 

dolor in reprehenderit in voluptate velit 

esse cillum dolore eu fugiat nulla 

pariatur. Excepteur sint occaecat 

Объект
Описание

Заголовок

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

laboris nisi ut aliquip ex ea 

commodo consequat. Duis 

aute irure dolor in. 

Объект
Описание



Если у вас в списке больше 3-4 пунктов, 

лучше использовать нумерованный список 

вместо маркированного.

  Pink
  Orange
  Green
  Blue

1.  Pink
2. Orange
3. Green
4. Blue

 
Нумерованые 
списки

Навигация
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Создание описаний к text-to-speech 

функциям это отдельный вид искусства. 

Делайте их доступными чтобы пользователи 

понимали что происходит, но при этом 

лаконичными, чтобы не тратить годы на 

прослушивание.

ДействиеДействие

      Это кнопка 
которая запускает 
действие. Нажав ее 
вы попадете на 
следующий экран.

      На следующий 
экран

 
Обозначение
Навигация
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Плохо Хорошо

“ “



Вставляйте описание над инпутом, а не в 

него. При последнем варианте чтение 

контента экрана попросту выдаст 

безсмыслицу — просто прочитает 

введенное значение, а не название поля.

Описание над 
инпутами

Плохо Хорошо

      Иван. Введите свой 
email.“       Имя Иван. Email 

Введите здесь.“

Иван

Введите свой email Email

Имя

Иван

Введите здесь

Навигация
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Взаимодействие При создание дизайнов для touch-устройств, 

всегда задумывайтесь об удобстве работы 

пальцами. Мы всегда делаем наши дизайны 

с минимальной тач-зоной в 7мм х 7мм, что 

примерно составляет площадь контакта 

пальца с экраном. Мы также оставляем 2 

миллиметра между элементами, чтобы 

избежать случайных нажатий. Если вы 

делаете элементы для большого пальца, 

делайте их шире 25 мм, что примерно равно 

ширине пальца взрослого человека.

Плохо Хорошо
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Тач цели

7mm

7mm



Как правило, в приложениях кнопки 

ассоциируются с действием, поэтому менять 

их на гиперссылки не стоит — это собъет 

юзера с толку.

 
Кнопки и 
гиперссылки

ДействиеДействие

Плохо

Взаимодействие
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Хорошо



Говоря о гиперссылках: не подчеркивайте 

текст который не является ссылкой. Как мы 

уже говорили — это сбивает с толку. Юзер 

может запутаться, когда нажмет на элемент 

и ничего не произойдет.

Это не
ссылка

Это не
ссылка

Кнопки и 
гиперссылки

Взаимодействие
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Предотвращение 
ошибок

Минимизируйте ошибки в процессе 

использования вашего продукта с помощью 

дизайна. Размещение полезных элементов 

вначале, скрытие или отделение элементов 

которые несут риск — все это помогает. 

Хорошей практикой является 

использование предупреждений для 

предотвращения риска и улучшения 

отказоуйстойчивости. Старайтесь сделать 

так, чтобы юзеры задумались о своих 

действиях в важных ситуациях. Не пускайте 

их в путешествие на автопилоте.

 

Дизайн
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Удалить файлы

Файл 1

Файл 2

Файл 3

Да, я хочу удалить их

Удалить

Поставьте галочку и 
нажмите  кнопку Удалить.

Удалить файлы

Файл 2

Файл 1

File 4

Файл 3

Файл 5

Удалить

Вы не сможете отменить 
действие, вы точно 

хотите удалить файлы?

Да Нет



Из за малых размеров мобильных устройств 

процесс ввода информации довольно не 

прост, поэтому удобно и правильно сразу 

показывать правильность введенных 

данных.Проверка данных

Предотвращение 
ошибок
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Плохо Хорошо

Телефон

Имя

Отправить

Неверный номер

Иван

01234 56789 !

Телефон

Имя

Отправить

Иван

01234 56789



Там где это возможно предоставляйте 

выбор значений вместо свободного поля 

для ввода — поможет избежать ошибок 

ввода.

Плохо Хорошо

Введите цвет

Выберите цвет

Розовый

Зеленый

Синий

Оранжевый

Цвет

Цвет

 

Свободный текст

Предотвращение 
ошибок
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Когда ввод данных является частью 

процесса, дайте пользователю возможность 

проверить данные перед отправкой, и, если 

это будет необходимо, возможность 

вернуться назад и исправить их. Проверка, подтверждение, 
исправление

Выбор товара

Товар 1

Предотвращение 
ошибок
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Товар 2

Товар 3

Товар 4

Товар 5

Купить

Проверка

Вы выбрали такие товары:

Товар 1
Товар 2
Товар 3
Товар 4
Товар 5
Нажмите Подтвердить, для 
покупки товаров или 
стрелку для изменения.

Подтвердить 



Если в вашем приложении можно удалять 

контент и делать другие опасные операции, 

позаботьтесь о предоставлении 

возможности отмены этих действий. Это 

может быть реализовано в виде корзины, 

которая очищается раз в неделю, или 

системы контроля версий, которая 

позволяет сделать шаг назад к предыдущей 

версии.

Отмена действий

Предотвращение 
ошибок
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Удалить файлы

Файл 1

Файл 2

Файл 3

Удалить

Корзина

Восстановить

Файл 4

Файл 5

Файл 3

Файл 4



Текст Вопрос не только в том как выглядит ваш 

шрифт, но и то, о чем он говорит. Это 

равносильно по важности, а может и 

важнее. Непонятное описание или 

инструкции сбивают пользователя с толку. 

Поэтому потратьте время и подумайте о том, 

что вы хотите донести и насколько 

эффективно вы это делаете. В плохом 

примере вы выберете Отменить чтобы 

отменить заказ, или же это отменит отмену?

OK

Вы хотите 
отменить этот 

заказ?

Отменить Да

Вы хотите 
отменить этот 

заказ?
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Нет

Плохо Хорошо



Разбивайте большие блоки текста, для 

упрощения чтения и слежения. Используйте 

максимум 5 строк в абзаце и вы не 

ошибетесь с размером. 

Lorem ipsum dolor sit amet, consectetur 

adipisicing elit, sed do eiusmod tempor 

incididunt ut labore et dolore magna aliqua. 

Ut enim ad minim veniam, quis nostrud 

exercitation ulamco laboris nisi ut aliquip ex 

ea commodo consequat. 

Duis aute irure dolor in reprehenderit in 

voluptate velit esse cillum dolore eu fugiat 

nulla pariatur. Excepteur sint occaecat 

cupidatat non proident, sunt in culpa qui 

officia deserunt mollit anim id est laborum.

Lorem ipsum dolor sit amet, consectetur 

adipisicing elit, sed do eiusmod tempor 

incididunt ut labore et dolore magna aliqua. 

Ut enim ad minim veniam, quis nostrud 

exercitation ulamco laboris nisi ut aliquip ex 

ea commodo consequat. Duis aute irure 

dolor in reprehenderit in voluptate velit esse 

cillum dolore eu fugiat nulla pariatur. 

Excepteur sint occaecat cupidatat non 

proident, sunt in culpa qui officia deserunt 

mollit anim id est laborum.

Плохо Хорошо
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У некоторых юзеров, например 

дислексиков, очень плохо с 

организационными способностями, поэтому 

старайтесь разбивать длинные абзацы 

текста на списки или диаграммы, что 

поможет показать информацию в 

компактном, порционном виде.

1. Розовый — Lorem ipsum dolor sit amet, 

consectetur adipiscing elit. Fusce 

pellentesque vehicula elit sed tincidunt. Nam 

bibendum tempus tellus ac interdum. 2. 

Оранжевый — Lorem ipsum dolor sit amet, 

consectetur adipiscing elit. Sed fermentum 

sodales orci. Class aptent taciti sociosqu ad 

litora torquent per conubia nostra, per 

inceptos himenaeos. 3. Зеленый — 

Pellentesque a nibh nibh, vel dictum risus. 4. 

Синий — Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

Розовый

Оранжевый

Зеленый

Синий

1.

2.

3.

4.

Текст
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Если вы используете аббревиатуру, 

обязательно добавьте расшифровку при 

первом использовании. А в общем — 

старайтесь их избегать: некоторым 

пользователям очень сложно запомнить их 

значение.

PPP
PPP 

(Pixel Perfect 
Precision)

Плохо Хорошо

 
Аббревиатуры
Текст
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 «Кликните здесь» отличный текст ссылки, 

правда? Нет, не правда! Не ясно куда ведет 

эта ссылка, да и у большинства 

пользователей тачскринов нет мышки, 

чтобы ей «кликнуть». Ссылка — это элемент 

навигации, а значит ее текст должен 

описывать свое направление и иметь смысл. 

Очень часто пользователи просматривают 

страницу в поисках ссылок на то, что они 

ищут. Не забывайте о других важных 

деталях, таких как размер файла, если это 

ссылка на файл.

Текст
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Кликни здесь

Pixel Perfect 
Precision 

Handbook
(25MB)
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Ссылочный текст



Обратная связь Предоставляйте пользователям обратную 

связь для чувства поддержки при 

выполнении различных задач. Нет ничего 

хуже, чем размышление о том, зависло 

приложение или нет, в момент обработки 

запроса, или нажатие на кнопку, которое 

ничего не делает. Обратная связь может 

быть в форме лоадера, сообщения, которое 

уведомляет пользователя о происходящем, 

звука, который даст знать, что действие 

осуществляется.
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Старайтесь предоставлять обратную связь в 

нескольких формах. К примеру, полагаться 

исключительно на звук для 

предупреждения значит, что глухие или 

расположенные в шумном окружении 

пользователи не поймут что уже что-то 

произошло и требует их внимания.

.
Мультисенсорность
Обратная связь
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Если что-то пошло не так — сообщите об 

этом в понятном виде, и предоставьте 

возможность вернуться назад.Сообщение об 
ощибке

Назад

Что-то пошло не так!
Не волнуйтесь, нажмите 
«Назад» чтобы вернуться 
на предыдущий экран.

Ошибка 04 тип 11
Произошла ошибка в 
библиотеке bus_1234. 
Это повлекло крах 
динамического 
состояния системы. 
Свяжитесь с админом на 
IT этаже.

OK

Обратная связь
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При дизайне форм располагайте сообщения 

об ошибках рядом с соответсвующими 

полями, а не вдалеке от них. Это поможет 

пользователям быстрее понять проблему.Близость ошибки
Обратная связь
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Вы работник ustwo

Иван

usthree !

Компания

Имя

Вы работник ustwo

Иван

usthree

!



Типографика Как говорилось в принципах Pixel Perfect, 

хорошая типографика жизненно важна в 

digital дизайне, и очень сильно влияет на 

доступность вашего продукта. Основы 

хорошей длины строки и интерлиньяжа, 

также очень важны, особенно для 

пользователей с когнитивными 

нарушениями. Сохраняя текст легким и 

разборчивым, вы помогаете пользователям 

без труда передвигаться от одной строки к 

другой.

Lorem ipsum dolor sit amet, consectetur adipiscing 
elit. Fusce pellentesque vehicula elit sed tincidunt. 
Nam bibendum tempus tellus ac interdum. Lorem 
ipsum dolor sit amet, consectetur adipiscing elit. Sed 
fermentum sodales orci. Class aptent taciti sociosqu 
ad litora torquent per conubia nostra, per inceptos 
himenaeos. Pellentesque a nibh nibh, vel dictum 
risus. Nunc congue vestibulum nibh non sollicitudin. 
Donec eget metus leo, eleifend tempus enim. Lorem 
ipsum dolor sit amet, consectetur adipiscing elit. 
Fusce pellentesque vehicula elit sed tincidunt. Nam 
bibendum tempus tellus ac interdum. Lorem ipsum 
dolor sit amet, consectetur adipiscing elit. Sed 
fermentum sodales orci. Class aptent taciti sociosqu 
ad litora torquent per conubia nostra, per inceptos 
himenaeos. Pellentesque a nibh nibh, vel dictum 
risus. Nunc congue vestibulum nibh non sollicitudin. 
Donec eget metus leo, eleifend tempus enim.

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.
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Минимальный размер шрифта который 

следует использовать — 12pt, хороший 

размер для чтения — 16pt (1em). Сделайте 

текст слишком маленьким, и пользователи 

будут страдать, пытаясь разобрать что 

написано, особенно на не особо резких 

экранах с маленькой плотностью.

Размер шрифта

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce 

pellentesque vehicula elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Sed fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent per conubia nostra, 

per inceptos himenaeos. Pellentesque a nibh nibh, vel dictum 

risus. Nunc congue vestibulum nibh non sollicitudin. Donec eget 

metus leo.

Плохо

Типографика
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Придерживайтесь длины строки ниже 80 

символов. Если сделать строку длиннее, то 

пользователь будет теряться где начало и 

где конец и текст будет тяжелее читать. 

Хороший диапазон к которому можно 

стремится — 45-75 символов, с оптимальной 

длинной в 66 символов включая пробелы  

(как сказано в Robert Bringhurst’s The 
Elements of Typographic Style).Длина строки

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce pellentesque vehicula elit sed tincidunt. Nam 
bibendum tempus tellus ac interdum. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed fermentum 
sodales orci. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. 
Pellentesque a nibh nibh, vel dictum risus. Nunc congue vestibulum nibh non sollicitudin. Donec eget metus leo, 
eleifend tempus enim. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce pellentesque vehicula elit sed 
tincidunt. Nam bibendum tempus tellus ac interdum. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed 
fermentum sodales orci. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. 
Pellentesque a nibh nibh, vel dictum risus. Nunc congue vestibulum nibh non sollicitudin. Donec eget metus leo, 
eleifend tempus enim.

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

Плохо

Типографика
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Достаточный отступ между строками 

позволяет глазу четко различать их, что в 

свою очередь помогает с движением в 

процессе чтения. Рекомендуемый отступ (он 

же leading) это 1.5 размера шрифта. Таким 

же образом отступ между параграфами 

должен равняться 1.5 отступам между 

строками. Отступ между абзацами не 

обсуждается.

 
Отступы

Плохо

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Fusce pellentesque vehicula 
elit sed tincidunt. Nam bibendum tempus 
tellus ac interdum. Lorem ipsum dolor sit 
amet, consectetur adipiscing elit. Sed 
fermentum sodales orci. 
Class aptent taciti sociosqu ad litora torquent 
per conubia nostra, per inceptos himenaeos. 
Pellentesque a nibh nibh, vel dictum risus. 
Nunc congue vestibulum nibh non 
sollicitudin. Donec eget metus leo.

Хорошо

Типографика
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Несколько строк текста всегда должны быть 

выровнены по левому краю, так как 

нелогичные отступы в отцентрированном 

или выровненном по ширине тексте могут 

стать проблемой для юзеров с трудностями 

в обучении. Выравнивание по ширине также 

пораждает раздражающие белые реки, 

протекающие через абзацы.Типографика

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

 
Выравнивание
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Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vest ibu lum n ibh non 

sollicitudin. Donec eget metus leo.

Lorem ipsum dolor sit amet, consectetur 

adipiscing elit. Fusce pellentesque vehicula 

elit sed tincidunt. Nam bibendum tempus 

tellus ac interdum. Lorem ipsum dolor sit 

amet, consectetur adipiscing elit. Sed 

fermentum sodales orci. 

Class aptent taciti sociosqu ad litora torquent 

per conubia nostra, per inceptos himenaeos. 

Pellentesque a nibh nibh, vel dictum risus. 

Nunc congue vestibulum nibh non 

sollicitudin. Donec eget metus leo.

Плохо Хорошо



Сохраняйте форматирование текста 

простым, чтобы добиться максимальной 

разборчивости для пользователей. Шрифты 

с засечками сложнее читать пользователям 

с дислексией или слабовидящим, так как их 

стиль может смешивать форму букв, а 

италик и подчеркивание добавляют 

визуальный шум. Предложение или абзац 

капителью также делает текст 

трудночитаемым. И КАЖЕТСЯ ЧТО ВЫ 

КРИЧИТЕ!

Типографика
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Пример
Пример
Пример
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Пример
Пример

Форматирование
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Избегайте двигающегося или мигающего 

теста, это может сильно раздражать людей с 

дислексией или слабовидящих. Эти 

эффекты могут вызвать эпилептические 

припадки, что также никуда не годиться.

Пример

 
Форматирование
Типографика
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Сокращайте текст только там где это 

действительно необходимо, так как это 

может скрывать нужный контент.

 
Сокращения

При…
При…
При…

Пример 1
Пример 2
Пример 3

Типографика
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Старайтесь не объединять текст с графикой. 

Где возможно, делайте это на уровне кода. 

Это дает возможность функциям text-to-

speech прочитать текст, а пользователям 

изменить цвет и размер текста исходя из 

личных предпочтений. Все это невозможно, 

если текст сделан картинкой.

Объединение 
текста и графики

Пример

+Пример

Типографика
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Цвет Старайтесь использовать наглядные иконки 

и цвета, чтобы упростить определение 

важного контента на странице. Цветовое 

кодирование удобно для идентификации 

различного типа контента — особенно 

полезно для пользователей с когнитивными 

нарушениями. И не забывайте про 

последовательность.

Визуальная 
наглядность

ИнформацияИнформация

Плохо Хорошо
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Кстати, не надейтесь только на цвет для 

передачи сообщения. Всегда добавляйте 

что-то еще. У некоторых мобильных 

устройств проблемы с контрастностью, либо 

условия использования далеко не 

идеальны, что может повлиять на видимость 

и цвета. Не забывайте, что около 8% мужчин 

страдают от различных форм цветовой 

слепоты, что может усложнить процесс 

распознания фигур, единственное отличие 

которых — цвет.

Цвет
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Успех

Неудача

Не надейтесь 
лишь на цвет
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Если вы используете цвет для подачи 

столбцов в графиках, добавьте второй 

признак по которому можно их различать. В 

этом случае мы дали разные паттерны синей 

и оранжевой областям.

Цвет
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Альтернативы
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Хороший контраст текста и фона —  лучший 

способ убедиться в том, что важная 

информация все еще доступна юзерам с 

различными формами цветовой слепоты 

или проблемами со зрением. Проверьте 

дизайн на необходимом устройстве при 

плохом освещении: убедитесь что контраста 

хватает в реальных ситуациях.Цвет
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Существует множество инструментов для 

проверки цветового контраста: Colour 
Contrast Analyser и Jonathan Snook’s web-
based checker — просто введите два цвета. 

Как минимум вы должны проходить стандарт 

АА! Конечно ААА лучше, но для него 

требуется намного больше контраста, что 

может навредить дизайну. Результаты могут 

отличаться для большого текста, больше 18 

пунктов (или жирного и больше чем 14 

пунктов)

Цвет
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Foreground

Background

Проверка 
контраста

AA

AA (Large)

AAA

AAA (Large)

http://www.paciellogroup.com/resources/contrastAnalyser
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Если вы захотите описать цвета без 

использования слов, то что вы сделаете? 

Оказывается отличное решение уже 

существует — ColorADD. Это простая 

система, которая представляет цвета 

используя символы. Комбинируя символы, 

которые отвечают за 3 основных цвета вы 

можете создавать целый спектр — будто это 

краски или чернила. Также можно делать 

темные или светлые оттенки цветов 

соединяя их с символами черного и белого 

цвета. 

 
ColorADD
Цвет
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Blue / 
Cyan

Red / 
Magenta Yellow White Black

http://www.coloradd.net
http://www.coloradd.net


На сайте ColorADD есть много другой 

информации, включая классные цветные 

карандаши для дальтоников.

 
ColorADD
Цвет
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Dark 
GreenBrick Dark 

Yellow
Dark 
Blue PurpleBordeaux Dark 

Brown

Light 
Green

Light 
Orange

Light 
Yellow

Light 
BluePink KhakiOrchid

GreenOrange Yellow Blue VioletRed Brown



Мерцание Пользователи со светочувствительной 

эпилепсией могут иметь проблемы с 

мерцанием при определенной частоте, если 

мерцание продолжается длительное время. 

Основная рекомендация заключается в 

отказе от использование элементов, 

которые мерцают больше чем три раза в 

секунду. Для более детальной информации 

читайте WCAG’s (Web Content Accessibility 
Guidelines) на странице “Three Flashes or 
Below Threshold”.
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Движение Движение может быть проблемой для 

людей, которые страдают необучаемостью 

или проблемами с вниманием, так как оно 

раздражает и снижает концентрацию на 

информации на странице. Те, кто читают 

медленно, захотят чтобы элементы были 

статичны. Так они смогут понять о чем речь. 

Если вы действительно хотите добавить 

двигающийся контент в ваш продукт, не 

запускайте его автоматически, делайте это 

по нажатию на плэй и предоставьте 

возможность нажать на паузу или стоп.
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Плохо Хорошо

Заголовок

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

ling ticker. Scrolling ticker. Scr

Заголовок

ker. Scrolling ticker. Scrolli

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 



Тестирование Еще одна хорошая практика применимая к 

доступности. Не забывайте проверять свое 

приложение в монохроме (black and white), 

приближенном виде и text-to-speech. 

Проверяйте на живых девайсах, а не 

симуляторах. Так вы действительно сможете 

понять как оно работает. В реальности 

лучшие тесты это те, которые делают люди, 

регулярно использующие эти функции.

83Pixel Perfect Precision

Text to 
speech Text to 

speech



В меню View > Proof Setup спрятаны самые 

распостраненные формы цветовой слепоты 

— отличный метод быстро проверить есть ли 

проблемы с контрастом в выбранной 

палитре. 

Цветовая слепота 
в Adobe

Тестирование
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Sim Daltonism это более продвинутое 

приложение для проверки доступности 

цветовой слепоты с возможностью 

различных видов предпросмотра. 

Приложение работает не только внутри 

Photoshop, но и отдельно, предоставляя 

плавающие окна которые могут менять 

размер и фильтрующие то, что находится 

под курсором мыши.

 
Sim Daltonism
Тестирование
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ДИЗАЙН И 
РАЗРАБОТКА
ДИЗАЙН
И
РАЗРАБОТКА



Дизайн и 
разработка

Дизайн это только часть релиза продукта. 

Разработка не менее важна. Существует 

отдельный барьер между ними: сначала 

завершается дизайн, затем он отправляется 

разработчику — классическая каскадная 

модель. Но, как правило, это часто приводит 

к плохим результатам. Намного лучше 

работать над проблемой вместе, командно, 

что и является основной идеей этой главы. 

Мы рассмотрим более эффективные пути 

перехода от дизайна к разработке, сохраняя 

время и уменьшая трудности.
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Основы Это первая основная точка в совместной 

работе. Грамотная коммуникация поможет 

программисту получить дизайн который 

намного легче в имплементации, а 

дизайнеру — билд похожий на сам дизайн. 

Общайтесь, обсуждайте свои решения и 

приходите к компромиссу, тем самым убирая 

напряжение из процесса. Как говорили в 

одной рекламе:  «Разговаривать — это 

хорошо»

 
Переговоры

88Pixel Perfect Precision



Старайтесь не ограничиваться своей 

задачей и больше работать вместе. Если у 

вас встреча по генерации дизайн-идей — 

пригласите на нее разработчиков. Вы не 

только узнаете мнение другой стороны, но и 

получите информациюю о том что 

технически возможно. В долгосрочной 

перспективе каждый член команды 

почувствует себя вовлеченным в процесс, 

что в конечном итогде приведет к более 

качественному продукту.

Взаимодействие
Основы
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Работая вместе более плотно, вы начнете 

изучать дисциплины друг друга и находить 

подводные камни. Понимая проблемы друг 

друга вы сможете решать их совместно, и 

проект будет приносить больше 

удовольствия. Дополнительный плюс 

обучения в большей независимости 

принятия решений. Будет возникать все 

меньше и меньше вопросов. Вы будете 

знать что можно делать, как это должно 

выглядеть и не потребуется задавать массу 

вопросов.

 
Обучение
Основы
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Точкой преткновения между дизайнерами и 

разработчиками зачастую выступает 

разница между дизайном макета и 

конечным дизайном приложения. 

Предыдущие советы о командной работе 

помогут уменьшить разницу, но, будем 

реалистами. Вместо того чтобы улучшать 

приложение попиксельно, подумайте, может 

лучше потратить это время на улучшение 

самого приложения. Нет ничего хорошего в 

продукте который отлично выглядит, но 

тяжел в использовании и постоянно глючит.

Будьте 
реалистами

Основы
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Подготовка Прежде чем начинать любой дизайн, 

узнайте как можно больше о 

предназначаемой платформе приложения. 

Размер экрана — хорошая точка 

отправления, также как и плотность 

пикселя. Не забудьте про битность (сколько 

цветов на самом деле покажет экран) и 

любые ограничения во взаимодействии и 

частоте кадров в анимации. Среда 

разработки также может вносить 

ограничения на эффекты рэндеринга и 

шрифты, так что проверьте и это.

 
Спецификации
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В процессе составления спецификации 

необходимо узнать о том, что именно вы 

должны предоставить разработчикам для 

завершения продукта.  Какие форматы им 

нужны: png, psd, векторы? Есть ли 

ограничения по цветам и эффектам? Нужно 

ли 9-slice исходники чтобы они могли 

масштабироваться в продукте? Получение 

точной информации сейчас позволит делать 

дизайн основываясь на любых требованиях 

с самого начала.

 
Доставка
Подготовка
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В дополнение к определению того, что вам 

нужно предоставить, сядьте вместе с 

программистами и обсудите совместную 

работу. Проект будет каскадным или agile? 

Как часто будут появляться билды 

приложения? Что вам нужно друг от друга, 

как вы будете обмениваться файлами? Как 

лучше отслеживать изменения и запросы? 

На этом этапе также важно запланировать 

регулярные ревью-сессии для обсуждения 

прогресса.

Рабочий процесс
Подготовка
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Версия

Объект
Описание

Объект
Описание

Объект
Описание

Объект
Описание

Проверка и итерации

Релиз



Неотъемлемой частью рабочего процесса 

является настройка подобия системы 

трэкинга. Разработчики захотят попросить 

недостающую информацию, записать баги, а 

дизайнеры захотят сообщить о визуальных 

изменениях или о замеченных багах. Делать 

это через email неудобно, поэтому 

используйте что-то более подходящие. Это 

может быть что-то простое типа общего 

todo-списка, либо полноценного софта для 

project менеджмента.

Трэкинг
Подготовка
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PPP–09 Работать над переводом

PPP–08 Предоставить шрифты

PPP–07 Выслать тестовый билд

PPP–06 Выравнять углы

PPP–05 Какой цвет текста?

PPP–04 Создать страницу выдачи

PPP–03 Нажатое состояние для кнопки

PPP–02 Поправить баг в управлении

PPP–01 Вырезать зеленый квадрат



Дизайн Ознакомьтесь c визуальными 

ограничениями прежде чем делать дизайн. 

Используйте шрифты которые доступны на 

девайсе и стилизуйте их так, чтобы можно 

было точно повторить это. Как правило с 

градиентами, тенью и обводкой нет никаких 

проблем, но более сложные эффекты могут 

быть невозможны. Если сомневаетесь — 

поговорите с разработчиком, чтобы узнать 

чем вы ограничены.Должная 
стилизация

96Pixel Perfect Precision

Плохо Хорошо

КнопкаКнопка



Чтобы поддерживать коллективное 

здравомыслие в команде старайтесь 

использовать реалистичный контент в 

дизайне. Очень плохо когда вам нужно 

возвращаться назад из-за нехватки места 

для текста. Также задумывайтесь о 

наихудших сценариях: слишком много слов 

или нет изображения — они обязательно 

обнаружатся когда приложение выйдет на 

свободу.Реалистичный 
контент

Дизайн
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Исполнитель

Песня
Исполнитель

Песня
Исполнитель

Песня
Исполнитель

Избранное

Lean & Agile
The ustwo Band

Pixel Monkey
Tony & Dones

Line Me Up
The Pixel Perfecti…

I Love Pixels!
The Pixel Perfecti…
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Очень редко дизайн проходит в один шаг, 

поэтому храните файлы так, чтобы вы в 

любой момент могли внести изменения и 

обновления. Это также помогает в тех 

случаях, когда разработчики просят 

исходники, чтобы увидеть как был создан 

дизайн, либо для экспорта каких-то 

элементов.

Все должно 
редактироваться

Дизайн
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Не забывайте делать дизайн различных 

состояний для объектов и экспортировать 

их в одном размере: выровненными и 

попиксельно идеальными.Состояния 
объекта

Дизайн
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Хорошо иметь наборы стилей по проекту. В 

них собраны все элементы и стили. Можно 

проверить что все выглядит целостно и 

затем отправить разработчику в виде 

справочного руководства. Также если этот 

файл актуален, то его можно использовать 

как стандарт для всех стилей и элементов 

проекта, не нужно проходить через каждый 

элемент и вносить изменения. Все что в 

этом документе — верно, а любые вариации 

можно проигнорировать. Это окрыляет!

 
Наборы стилей
Дизайн
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Неактивна
Основной текст
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Proxima Nova Light 30pt #757575
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Один из способов понять что все выглядит и 

работает так как вы хотите — представить 

дизайн в коде. Можно написать код с нуля, 

но намного проще создать мокап как 

обычно, а потом экспортировать слои и 

стили прямо в CSS. Если код готов, то вы на 

верном пути к созданию интерактивного 

прототипа в HTML. Дизайны действительно 

оживают, когда их используют на 

предназначаемом устройстве.Дизайн в коде
Дизайн
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.square_pink {
@ background-color: #ed0082;
@ position: absolute;
@ left: 32px;
@ top: 128px;
@ width: 96px;
 @ height: 96px;
}
.rectangle {
@ background-color: #e8e8e8;
@ position: absolute;
@ left: 32px;
@ top: 128px;
@ width: 96px;
 @ height: 96px;
}



Как говорилось в других частях, старайтесь 

избегать использования цветовых 

профилей, так как они могут создать 

несоответствие между дизайном и кодом.Цветовые 
профили

Дизайн
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Цветовой профиль

Код
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Плохо Хорошо



Доставка Старайтесь сдавать работу вовремя. Сдача 

работы не в срок всегда вызывает 

неприятное ощущение, и вероятность 

«застрять» в проекте. Если какой-то этап 

занимает больше отведенного времени, 

заранее поговорите с командой. Так все 

смогут адаптироваться к изменению 

графика. Есть шанс, что это не станет 

проблемой, и за это время члены команды 

смогут поработать над чем-то еще.

 
Сроки
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Если вы храните файлы в порядке, то 

передача их от дизайнера к программисту и 

обратно проходит намного эффективнее. 

Называйте и структурируйте все логически 

и последовательно, используя систему 

которая понятна всем. Это также касается 

слоев в Photoshop: возможно кто-то еще 

захочет с ними поработать. 
Порядок
Доставка
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Rectangle.png

Square Blue.png

Square Green.png

Square Orange.png

Square Pink.png

Элементы

Screen.psd

Дизайн

Проект

Rectangle.png

Square.png

Square copy.png

Square copy 2.png

Square copy 3.png

Untitled.psd

Проект



Система имен файлов играет большую роль 

в создании хорошей организационной 

структуры. В начале проекта пообщайтесь с 

разработчиками и узнайте как лучше 

называть файлы: как правило у них уже есть 

предпочитаемый метод и вы можете 

использовать его. Хорошо если имена 

базируется на иерархической системе, 

которая начинается с широкой 

характеристики компонента с последующим 

добавлением большего количества 

информации. В конечном итоге вы можете 

получить что-то типа:

& type_location_identifier_state

Type — это категория к которой 

принадлежит компонент, к примеру:

 bg&(background)  btn& (button) 
& icn& (icon)& & & & & img& (image)

Следующим шагом будет добавление 

экрана или места где этот компонент 

появляется (global значит что он 

используется в нескольких местах):

& bg_help        btn_home        icn_global

Затем добавьте уникальный идентификатор. 

К примеру, кнопки на экране home, которые 

будут добавлять или удалять документы 

должны быть названы:

& btn_home_new        btn_home_delete

Если у компонента есть несколько 

состояний — добавьте их в конец:

& btn_home_new_default 
& btn_home_new_highlighted

Представленная система использует нижний 

регистр и подчеркивания вместо пробелов 

в именах. Этот метод мы используем в 

ustwo. Существует метод под названием 

CamelCase, в нем не используются пробелы 

а разделителем выступает верхний регистр: 

& BtnHomeNewDefault 
& BtnHomeNewSelected
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Система имен



106Pixel Perfect Precision

Заголовок

Объект
Описание

Объект
Описание

Объект
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Объект
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icn_global_signal_full
btn_global_menu_default

btn_home_play_pink_default

btn_home_play_orange_default

btn_home_play_green_default

btn_home_play_blue_default

icn_global_battery_full
btn_global_search_default

bg_home_description

Доставка
Система имен



Экспортируйте файлы в форматах, которые 

не ухудшают качество, таких как PNG, так 

как среда разработки в любом случае 

применит свое сжатие.Не сжимайте 
изображения

Доставка
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При отправке дизайна старайтесь добавлять 

как можно больше полезной информации 

для разработчиков. Громадные документы, 

перечисляющие размеры элементов 

каждого макета, скорее всего будут 

проигнорированы.  А прототипы, которые 

демонстрируют как приложение работает и 

видео, которое показывает желаемую 

скорость и стили эффектов могут 

действительно помочь.Спецификации
Доставка
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Фильм

Статика
Я не двигаюсь

Статика
Я не двигаюсь

Статика
Я не двигаюсь

Смотри!
Я буду двигаться

Фильм.avi
Заголовок

Объект
Описание

Объект
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Объект
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Объект
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Заголовок
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Объект
Описание

Объект
Описание

Объект
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Заголовок

Заголовок

Объект
Описание

Lorem ipsum dolor sit amet, 

consectetur adipisicing elit, 

sed do eiusmod tempor 

incididunt ut labore et 

dolore magna aliqua. Ut 

enim ad minim veniam, quis 

nostrud exercitation ulamco 

laboris nisi ut aliquip ex ea. 

Объект
Описание

Объект
Описание

Объект
Описание

Объект

Search results



До того как отправлять файлы 

разработчику, проверьте все ли на месте, а 

затем перепроверьте все еще раз, для 

уверенности. Проверь, и еще 
раз проверь.

Исходники

Состояния

Набор стилей

Процесс

Проверь еще раз

Доставка
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Мы уже рассмотрели много правил дизайна, давайте углубимся в 

кое-что специфическое. Photoshop в ustwo — инструмент на 

каждый день, также как и в индустрии в целом, поэтому очень 

важно знать как им правильно пользоваться. В следующих 

разделах мы покажем вам некоторые методы и техники которые 

мы используем. 
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ЦВЕТОВЫЕ 
ПРОФИЛИ

Photoshop



Настройки 
системы

Чтобы избежать разницы в цвете между 

Photoshop и Mac OS X, вы должны 

правильно выставить цветовые настройки. В 

первую очередь убедитесь что в System 

Preferences > Displays > Color установлено 

устройство, которое вы сейчас используете. 

В нашем случае — Color LCD.
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Photoshop 
настройка цветов

Затем в Photoshop зайдите в Edit > Color 

Settings … и поменяйте Working Spaces > 

RGB на Monitor RGB - Display. Также 

отключите Color Management Policies > RGB.
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Photoshop Save 
for Web

Также в Save for Web опция Convert to sRGB 

должна быть отключена, и Preview должно 

быть выставлено в Monitor Color. После 

этого ваши цвета должны быть 

одинаковыми.
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Color Faker Несмотря на то, что предыдущие советы  

помогут настроить продукты Adobe для 

повседневных задач, вам возможно 

придется предпринять дополнительные 

действия, если у вас есть проблемы с 

цветом в таких приложениях Apple как 

Xcode или Keynote. Это связано с 

восприятием профилей в OS X. Для более 

детального описания прочитайте OS X Color 

Meters and Color Space Conversion, либо 

просто скачайте Color Faker и включите его.
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ПИКСЕЛЬНАЯ 
ТОЧНОСТЬ

Photoshop



Shape Layers Мы любим Shape Layers — весь наш рабочий 

процесс построен на них. Так как это 

векторы, они полностью редактируемы:  

можно масштабировать, изменять форму 

без потери качества, и они менее 

прожорливы в плане ресурсов в отличие от 

Smart Object или растра. Победный вариант!

Плохо Хорошо
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Также старайтесь использовать вектора в 

той части дизайна, где вы можете 

инстинктивно использовать растр. Пример 

— маски слоя. Это значительно ускорит 

универсальность и быстродействие 

исходника. Еще один совет — использовать 

немаскированный Shape Layer для 

бэкграундов, что добавляет преимущество 

того, что заливка будет автоматически 

растягиваться при увеличении размера 

канваса. Супер!

Другие векторы

Плохо Хорошо
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Посмотрите на удар растра по 

производительности. Обратите внимание на 

выделенные значения. Это размер 

исходника со слоями на предыдущей 

странице. Векторный дизайн занимает 

только 113.9 KB памяти, а полностью 

растровая версия целых 3.47 MB! На 

больших файлах вы можете сохранить себе 

сотни мегабайт памяти.

 
Быстродействие

Плохо Хорошо
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Live Shape 
Properties

Photoshop CC имеет замечательное 

нововведение в панели Properties — Live 

Shape Properties. Каждый новый Shape Layer 

теперь имеет редактируемый набор 

значений для точнейшего измерения и 

позиционирования. Хотите поменять радиус 

закругления? Просто выберите шэйп и 

измените необходимые значения. Также, в 

отличие от прежних версий Photoshop, 

нажатие на transform или resize шейпа не 

искажает радиус закругления. Море 

сохраненного времени.
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Редактор углов Если вы используете версию фотошопа 

отличную от CC, то у вас все еще есть 

возможность редактирования радиуса 

скругления (corner radii) после того как вы 

нарисовали шейп — Corner Editor. Если он 

установлен, вы можете выбрать слой шэйпа, 

открыть File > Scripts > Corner Editor и 

поменять значение радиуса, вы также 

можете назначить разный радиус каждому 

углу, аналогично CC. Есть возможность 

использовать разичные стили, вы не 

ограничены лишь скруглением углов.
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Эффекты слоя Мы также любим Layer Effects, поэтому 

стараемся как можно больше стилизовать с 

их помощью. Эффекты полностью 

редактируемы, масштабируемы в 

соотношении с их шэйпами, а также их 

можно скопировать и применить к другим 

слоям.
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Связанные Smart 
Objects

Linked Smart Objects работают точно также 

как и обычные Smart Objects, за 

исключением того, что они ссылаются на 

внешние файлы. Это дает возможность 

команде дизайнеров использовать единую 

библиотеку компонентов интерфейса, при 

этом любой апдейт исходников будет 

затрагивать все связанные дизайны — 

очень удобно. Создавать Linked Smart Object 

очень просто, просто нажмите Place Linked в 

меню File, и выберите объект который вы 

хотите импортировать.
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Панель Info Включите инфо панель когда индикации 

курсора недостаточно. Она не только 

показывает детальные размеры. Ее также 

можно настроить на отображение значений 

цвета и прозрачности, что позволит вам 

быстро проверить последовательность в 

дизайне.

Some Text

W
H
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Привязка к 
пиксельной сетке

В Photoshop CS6 и выше есть глобальная 

опция — привязать вектор к пикселям. 

Убедитесь что в настройках пункт Snap 

Vector Tools and Transforms to Pixel Grid 

выбран (по умолчанию он включен). 

Намного проще когда знаешь что каждый 

Shape Layer который ты рисуешь будет 

пиксельно четким. 
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Шорткаты для 
пиксельной сетки

Иногда нужно отказаться от попиксельной 

точности. Если такое происходит часто, 

почему бы не автоматизировать этот 

процесс? Создайте экшн, назначьте 

клавишу для него, нажмите Record, зайдите 

в настройки и включите Snap Vector Tools 

and Transforms to Pixel Grid. Затем 

повторотите то же самое для выключения. 

Теперь не нужно каждый раз заходить в 

настройки.
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Shape Layer 
Options

В Photoshop CS5 прямоугольники и 

скругленные прямоугольники имеют 

встроенную опцию для помощи в 

пиксельной точности: Snap to Pixels. Чтобы 

получить доступ к этой опции нажмите на 

выпадающее меню справа от шэйпов в 

тулбаре. Выберите эту опцию 

индивидуально для прямоугольника и 

скругленного прямоугольника, так как они 

независимы друг от друга.
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Вытягивание Будьте аккуратнее с зумом в Photoshop CS5. 

При использовании клавиатуры для 

переключения точек сдвига у слоя Shape — 

объем вытягивания изменяется в 

зависимости от зума. Чтобы гарантировать 

сдвиг на 1px, установите масштаб 100% и 

нажмите стрелочку 1 раз. При зуме в 200% 

точки сдвинуться на 0.5px (т.е. наполовину), 

создавая размытые углы — не хорошо. В 

CS6 точки двигаются на 1px вне зависимости 

от зума. Отключите привязку для точности.

128Pixel Perfect Precision



Привязка В Photoshop есть множество удобных 

инструментов, помогающих с попиксельной 

точностью. В первую очередь включите 

привязку: зайдите в View > Snap и 

удостоверьтесь что она включена. Теперь 

ваши объекты будут привязываться к 

другим объектам и гайдам в макете, что 

сильно помогает в выравнивании. Подменю 

Snap To позволяет вам изменять объекты, 

которые Photoshop использует для 

привязки.
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Выравнивание и 
распределение

В Photoshop, как и в других графических 

приложениях есть множество опций для 

выравнивания и распределения. Их можно 

найти в Layer > Align and Layer > меню 

Distribute.
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Сетка Сетка очень сильно помогает в разметке 

дизайна. В примере выше десятипиксельная 

сетка с расстоянием в 10 пикселей, что 

позволяет легко считать размер пикселя 

без особого внимания к сетке. Зайдите в 

Photoshop > Preferences > Guides, Grid & 

Slices чтобы сделать настройку.
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GuideGuide Бесплатное дополнение к Photoshop под 

названием GuideGuide поможет в 

автоматизации создания сетки. После 

установки вы можете найти его в меню 

Window > Extension. Изменяя параметры 

ввода, длинну column и gutter, или если вы 

уже допустим нанесли их на кусочек бумаги, 

вы можете просто ввести значения и 

автоматически получить нужную сетку. Для 

каждого инпута есть подсказки.

Some Text
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Стандартное 
значение Global 
Light

Это одна из тех мелочей, которая при 

неаккуратности может наделать проблем. 

Объекты c кастомными настройками Global 

Light при копировании в другой документ по 

умолчанию получают значение в 120°. Это 

может существенно смешать дизайн. Чтобы 

избежать этого закройте все свои открытые 

файлы и зайдите в Layer > Layer Style > 

Global Light… и измените значение угла по 

умолчанию на что-то более 

распространенное, например 90°.

90°

120°

drag to new 
document
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Предпросмотр Тестируйте, тестируйте, тестируйте еще раз 

и потом еще немного тестируйте. Отличная 

практика — проверять дизайн на 

предназначенных девайсах. Существует 

множество приложений предоставляющих 

предпросмотр прямо из Photoshop, т.е. не 

нужна вся эта беготня вокруг сохранения 

файлов и копирования их на телефон. Стоит 

обратить внимание на Skala Preview для iOS 

и Android и Android Design Preview для... ну, 

я думаю вы поняли для чего.

Тут текстТут текст
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ТЕХНИКИ
Photoshop



Цвета объектов У шэйпов и текста удобно менять цвет 

используя настройки самого объекта, а не 

эффект Color Overlay Layer. Преимущества 

этого: нет необходимости открывать окно 

Layer Style если вы хотите поменять цвет и 

объект проще найти в панели Layers. 

Давайте попробуем: как быстро вы можете 

найти голубой квадрат в каждом из 

примеров вверху?

Плохо Хорош

Тут текст
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Градиент объекта Точно также и с градиентами — используете 

слой gradient fill вместо Layer Effect если это 

возможно.

 

Тут текст
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Вне зависимости от типа используемого 

градиента убедитесь что опция Dither 

активирована. Это поможет сгладить 

переход цвета и избежать полосатости. В 

Photoshop CS5 вы можете применять dither 

только к слою градиента, а в версии CS6 и 

выше применение доступно для обоих. 
Сглаживание
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Группируйте 
стили слоя

Старайтесь не растягивать Layer Effects 

объекта между несколькими слоями. 

Намного лучше если они вместе: так 

соблюдается порядок и намного проще 

копировать и вставлять стили.

Плохо Хорошо
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Масштаб 
эффектов слоя

Хоть вы и можете выбрать опцию Scale 

Styles когда меняете размер всего 

документа через Image Size, бывают 

ситуации, когда вы хотите увеличить 

масштаб (scale) определенных слоев и 

эффектов. При изменении размера одного 

объекта, стиль не подстраивается по 

размеру автоматически. Можно 

использовать опцию Scale Effects для 

решения этого вопроса. Вам необходимо 

знать процентное изменение оригинального 

шэйпа чтобы подогнать размер. Эту опцию 

можно найти нажав правой кнопкой на 

иконку fx у слоя.

Масштаб эффектов в 200%

Масштаб в 200%
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Layer Effect 
Strokes

Возможно вы думаете что единственный 

способ создать обводку с помощью Layer 

Effects — опция Stroke? На самом деле 

существует несколько способов добавить 

ее к шейпу. Используя Inner/Outer Glows и 

Shadows, со значением Choke равным 100%, 

вы сможете получить цельный контур. 

Stroke всегда будет вверху, затем будет 

Inner Shadow и Inner Glow и в самом низу 

Drop Shadow. Недостатки? При большей 

ширине они могут размываться, и Choke 

может вызвать шершавость на скругленных 

углах.
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Layer Effect vs. 
Vector Strokes

Если вы хотите качественной обводки в 

Photoshop CS6 или ниже — добавьте 

векторную обводку, но не как Layer Effect, а 

прямо к слою шейпа. Вы не только 

выиграете в качестве, но и получите 

возможность выбирать скругленные, 

квадратные, косые углы или пунктирные 

очертания. Обводку также можно 

уменьшить до полупикселей, что может 

пригодится для iOS, так как строук можно 

выставить в 0.5px, которые затем 

увеличатся до 1px на ретине.

Плохо Хорошо
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Сложные 
векторы

Для создания сложных векторов лучше 

использовать Illustrator, а затем скопировать 

и вставить контур в Photoshop как Shape 

слой. Убедитесь что вы сделали весь контур 

в Illustrator, иначе он не симпортируется 

правильно.  Запомните  это с помощью 

стишка: «Cо строком не шути, в векторе 

обводи». Если у вектора сложная форма: к 

примеру многоцветная иконка для рабочего 

стола, то ее лучше вставить как Smart Object
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Вставляем из 
Illustrator

Есть один каприз при вставке Shape Layers 

из Illustrator. Так как объект может 

сдвинуться off-centre на пол пикселя по 

одной или обоим осям, это может повлечь 

за собой размытые грани. В CS6 это не 

вызовет проблем, так как есть pixel 

snapping. Всегда проверяйте сдвинулся ли 

шейп и возвращайте его в исходную 

позицию. 

Плохо Хорошо
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Режимы 
наложения

При создании эффектов не забывайте 

использовать режимы наложения только на 

тех объектах, которые затем будут слиты с 

другими слоями. В примере выше слой 

Highlight будет экспортироваться отдельным 

файлом, но при показе слоя отдельно 

режим наложения пропадает и становится 

чёрно-белым градиентом.

Плохо
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Лучший вариант воссоздать эффект — 

использовать слой, который не зависит от 

того что под ним.

Хорошо
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Выравнивание 
текста

При добавлении текста упрощайте себе 

будущее, добавляя выравнивание абзаца в 

соответствии с дизайном. Текст будет 

выглядеть корректно даже если 

поменяется.

Оригинальный текст

Новый текст

Оригинальный текст
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Абзацы Абзацы текста лучше помещать в контейнер 

(Paragraph Text), а не делать переносы 

вручную (Point Text). Текст и шрифт очень 

часто изменяются. При правильном 

контейнере тексты выравниваются 

автоматически, давая нам возможность 

легко изменять абзац.

Плохо Хорошо
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Конвертация в 
Paragraph Text

К счастью, Photoshop позволяет 

конвертировать Point Text в Paragraph Text и 

наоборот, через меню Text > Convert to 

Paragraph Text / Convert to Point Text, либо 

кликнув правой кнопкой по слою, выбирая 

ту же опцию. В CS5 вы можете сделать это в 

меню Layer > Type.
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Автоматический 
перенос

Большинство девайсов не поддерживают 

автоматический перенос. Для большей 

точности не используйте его в дизайне.

Плохо Хорошо
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Интерлиньяж Интерлиньяж, который установлен в 

Photoshop по умолчанию, немного 

плотноват для комфорта. Оцените 

насколько лучше текст смотрится после 

увеличения значения по умолчанию (Auto) 

до 20pt.

Плохо Хорошо
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Сглаживание 
текста

В Photoshop есть несколько типов 

сглаживания, попробуйте все и определите 

вариант, который дает лучший рендеринг и 

четкость. Как правило, Crisp довольно 

универсален. Если вы работаете с текстом, 

который будет генерироваться где-то в 

другом месте, то выберите опцию которая 

максимально соответствует сглаживанию 

целевого экрана.

Нет Sharp

Crisp Strong Smooth
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Photoshop CC также имеет опцию 

сглаживания, которая повторяет рендеринг 

операционной системы на субпиксельном 

уровне. Это позволяет получить 

представление о виде текста в браузере, 

например. Стоит отметить что субпиксели в 

Photoshop являются оттенками серого, не 

RGB, в отличие от браузеров. Больше 

информации в посте Realmac Software’s 

Working with Type in Photoshop 

Система

Mac LCD Mac
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Списки При создании списков, особенно если 

рядом c ними есть графика, намного проще 

разместить все описания в один текстовый 

блок, и выставить необходимый 

интерлиньяж, чем создавать каждой линии 

отдельный слой. Это не только сохранит 

контент идеально выровненным но и 

упростит работу с ним в будущем.

Плохо Хорошо

Текст

Текст

Текст

Текст
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Предпросмотр Разрещающая способность мобильного 

телефона (PPI), как правило, больше чем у 

компьютера. Это значит, что физический 

размер дизайнов будет меньше на вторых, 

чем на первых. Чтобы быстро проверить 

размер текста и элементов отдалите дизайн 

пока он не станет размером с экран 

телефона, и если какой-то элемент выглядит 

маленьким — увеличьте его.

Текст
Текст
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ОРГАНИЗАЦИЯ
Photoshop



Настройка Layers 
Panel 

По умолчанию Photoshop будет добавлять 

«copy» после каждого дубликата слоя — это 

раздражает. Чтобы отключить эту функцию и 

победить визуальную суматоху зайдите в 

Layer Panel Options и уберите галочку с Use 

Default Masks on Fill Layers, Expand New 

Effects, и Add “copy” to Copied Layers and 

Groups. Каждая мелочь важна.
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Имена слоев Не будьте эгоистами — называйте слои 

своими именами. Это не только упростит 

жизнь тому кто работает с вашими файлами, 

но и заставит клиентов подумать что ваша 

организованность просто невероятна. Совет 

профессионалов: давайте слоям имена 

сразу во время создания, чтобы не делать 

это в спешке, когда дедлайн уже подошел.

Плохо

Текст
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Групповое 
переименование 
слоев

Для пакетного переименования слоев 

скачайте скрипт Group Layer Renaming от 

Kamil Khadeyev. Он делает именно то, о чем 

говориться в названии: позволяет 

переименовывать слои, добавлять текст и 

порядковый номер используя переменную 

%n.

До После
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Упорядочивание 
слоев

Чтобы сделать исходники особенными, 

убедитесь, что вы не только называете слои 

правильно но и логически верно 

выстраиваете их. Хорошая практика — 

выстраивать слои по порядку их появления 

в дизайне: слева направо, сверху вниз, как 

книгу (извините, если ваш родной язык идет 

в другом направлении)

Плохо

Some Text
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Поиск Совмещая организацию и возможности 

поиска Photoshop, мы получаем мощный 

способ работы с макетами. К примеру, 

добавление префиксов “btn” или “icn” к 

названию слоя даст вам возможность 

быстрой сортировки по содержанию. 

Отлично подходит для ситуаций, когда 

нужно применить новый стиль для 

нескольких кнопок. Вы можете искать по 

типу, эффектам и слою (цвету). Поиграйтесь 

и посмотрите какие другие системы 

фильтров вы можете использовать.

по Имени по Типу

Some Text
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Цветовое 
кодирование

Сверху представлен пример цветового 

кодирования слоев, упрощающий 

навигацию. Старайтесь оставлять основные 

элементы нетронутыми, чтоб ваша панель 

не выглядела как мешок с гирляндами. 

Чтобы выбрать цветовой лэйбл нажмите на 

слой правой кнопкой.

Серый (“нейтрал”) 
используется для 
референса — скрины и 
прототипы

Основные элементы  
не имеют выделения

Зеленый выделяет 
различные состояния 
одной кнопки

Красный (“опасно”) для 
старых, ненужных 
элементов

Окно попапа
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Раскрытые 
эффекты слоев

Как  неряшливый гость, раскрытые 

эффекты могут мешать поиску вещей, 

которые вам действительно нужны. Держите 

их свернутыми для всеобщего блага.

Плохо
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Удаляйте все 
пустые слои

Cтарайтесь не разбрасывать пустые слои 

или группы, так как они создают ненужный 

беспорядок. Есть удобный скрипт в меню 

File > Scripts под названием Delete All Empty 

Layers. Он делает именно то, о чем вы 

думаете.

Плохо
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Remove Unused 
FX

Эксперименты с дизайном пораждают 

множество незадействованных эффектов. 

Обычно нужно удалять их по одному, но 

расширение Remove Unused FX удаляет всё 

за один клик.

До После
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Блокировка 
слоев

Замок — хороший способ защитить объект 

во время работы. Не забудьте снять его до 

передачи файла другому дизайнеру. 

Закрытый слой где-то в глубине файла не 

даст вам удалить или сдвинуть группу. Это 

раздражает.

Плохо
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Композиция 
слоев

Композиция слоев (Layer Comps) —

действительно удобный метод сохранения 

нескольких вариантов дизайна в одном 

файле. На начальном уровне они дают 

возможность показывать или скрывать 

различные слои, показывая различные 

конфигурации контента. Вы также имеете 

возможность включать/выключать 

индивидуальные эффекты и даже 

модифицировать позицию объекта. Не 

забывайте сохранять ваши изменения в 

композицию нажатием кнопки update.

Текст Текст Текст

Текст Текст Текст
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ЭКСПОРТ
Photoshop



Генератор Генератор — одна из лучших новых функций 

в Photoshop CC, позволяющая вам 

экспортировать слои или группы просто 

добавляя расширение файла в их имя. 

После активации в меню File > Generate, 

генератор обработает и создаст папку с 

файлами, автоматически обновляя их при 

любых изменениях исходника — ура! Есть 

параметры изменяющие размер и качество 

изображения, можно выводить несколько 

версий одного файла. Подробнее в 

Generate image assets from layers
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Скрипты экспорта Для тех кто не использует Photoshop CC 

существует свой способ автоматизации 

экспорта. Вы можете использовать наши 

ustwo Crop & Export скрипты (смотрите 

следующую страницу). Для начала вам 

нужно поработать с исходниками: добавьте 

каждый отдельный объект для экспорта в 

отдельный слой или группу и дайте ему имя. 

Количество слоев в группе не имеет 

значения. Также, разделяя компоненты как 

в примере выше, вы закончите с удобным 

reference sheet.
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После сортировки используйте любой из 

наших скриптов чтобы эскпортировать все 

отдельные слои в PNG, быстро и без 

проблем. Просто скопируйте их из папки 

Scripts в PPP Extras в вашу папку Adobe 

Photoshop CSx/Presets/Scripts 

(пере)запустите  Photoshop и вперед! После 

установки их можно найти в меню File > 

Scripts. 

ustwo Crop & Export [filename][layername] 
Этот скрипт нарежет и экспортирует  

каждый файл с именем файла формата 

[filename][layername].png, т.е. слой с именем  

_normal из button.psd будет называться 

button_normal.png.

ustwo Crop & Export [layername] 
Такой же скрипт как выше, только он не 

добавляет имя файла, т.е. слой из 

предыдущего примера будет 

экспортироваться как _normal.png

ustwo Crop & Export +1px [filename]

[layername] 
В этом случае файл будет иметь отступ в 1px 

с каждой стороны для корректного 

отображения во Flash. Имя файла как в 

обычном Crop & Export. 

ustwo Crop & Export +1px [layername] 
Такой же скрипт как предыдущий но с 

альтернативным методом нейминга.

Есть также несколько дополнительных 

скриптов, которые не будут нарезать слои, а 

исходить из размеров в Photoshop. Это 

может пригодиться в screen comps, где у 

контента может меняться размер, но при 

этом нужны одинаковые пропорции всех 

экспортируемых PNG.

ustwo Export [filename][layername]

ustwo Export [layername]

Скрипты экспорта
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Save for Web Посмотрите на разницу в размерах двух 

PNG файлов. Save As… создало файл 

который на 32 килобайта больше чем Save 

for Web. Стоит использовать второй.
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Уменьшаем 
размер файла

Попробуйте сконвертировать файл в 8bit 

PNG, если вам не нужна прозрачность. В 

примере выше нет потери качества, при 

этом размер файла уменьшился больше чем 

наполовину.
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ImageOptim ImageOptim может сэкономить еще больше 

килобайт пространства. Просто перетащите 

файлы в главное окно и наблюдайте за 

процессом. Приложение работает с 

изображениями форматов PNG, JPEG и GIF, 

удаляя ненужные метаданные, такие как 

компоненты и цветовые профили, также 

оптимизируется используемая компрессия. 

Нет особого смысла в использовании 

ImageOptim при разработке для iOS, 

подробнее в статье PNG compression and 

iOS apps.
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Уменьшаем 
размер файлов 
Photoshop

Хороший способ сбросить немного веса с 

исходников —  скрыть все слои. Это не 

всегда практично, особенно если дизайн 

должен иметь определенную визуальную 

комбинацию для передачи смысла, но это 

может быть удобно, если вы пересылаете 

исходники и гонитесь за минимальным 

размером. Используйте ZIP компрессию для 

улучшения результата: вы можете сжать 

PSD файл более чем на 90%.
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565 Не все устройства отображают множество 

цветов. Это может визуально навредить 

вашим файлам, что особенно заметно в 

градиентах и прозрачности. Чтобы избежать 

этого конвертируйте их в 565 картинки с 

помощью Ximagic ColorDither. Он уменьшает 

битность изображения c 24 бит до 16 бит 

(поддерживается на старых экранах 

мобильных телефонов) и применяет 

сглаживание, компенсирующее уменьшение 

цветов. Имя 565 пошло из 5+6+5 битов в 

канале 16-ти битного RGB изображения.
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Применять 565 к группе файлов очень 

трудозатратно, намного проще ускорить 

процесс используя Actions и Batch tool. 

Запишите Action, который применяет 

фильтр, экспортирует результат через Save 

for Web (эта опция лучше чем Save and Close 

в меню Destination, которая увеличивает 

размер файла), и закрывает файл без 

изменения. Затем просто запустите экшн в 

Batch tool с настройкамии как в примере 

выше. Файлы будут экспортированы в место 

для Save for Web по умолчанию.

 
Batch
565
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СОВЕТЫ
Photoshop



Обводка Временами однопиксельная обводка (stroke) 

может выглядеть слишком тонкой на 

скругленных краях. Для усиления ее без 

увеличения толщины добавьте Glow с 

настройками как выше. Разница 

практически неуловима, но это 

действительно помогает.

Нет свечения 

Свечение
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Затухающие 
круги

Круговое затухание очень просто сделать 

используя эффект Stroke. Фишка в 

использовании Fill Type: Gradient и Style: 

Angle
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Быстрый блеск Если вы хотите быстро придать объекту 

блеск, попробуйте использовать эффект 

Inner Shadow белого цвета с маленькой 

прозрачностью. Будьте аккуратны, так как 

его форма будет базироваться на верхнем 

углу родительского слоя, это значит что 

любые непрямые секции будут отражены в 

блеске.
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Добавляем шум
с Inner Glow

Можно добавить простую текстуру шума к 

объекту используя эффект Inner Glow. 

Выставьте Source — Center и Size — 0, затем 

изменяйте величину используя настройки 

Noise.
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Извлечение лого Если у вас не выходит сделать копию 

логотипа — попробуйте этот метод. Как 

вариант, вы можете попробовать зайти на 

сайт нужной компании и поискать доступные 

для скачивания PDF. Их можно открыть в 

Illustrator и вытянуть оттуда любые 

векторные логотипы.

Найдите логотип на белом фоне
Image > Adjustments > Invert затем Select 

All и Copy

Image > Adjustments > Desaturate

Создайте новый слой залитый цветом, 

добавьте Layer Mask, Option + клик на ней 

и потом Paste — добавляем маску из лого 

который вы скопировали

Image > Adjustments > Levels и 

используйте black point 

eyedropper для выбора главного 

Та-дам! У вас есть лого на прозрачном 

бэкграунде.

183Pixel Perfect Precision



Star Fields Поиграйтесь с настройками в панели 

Brushes чтобы создать различные эффекты, 

к примеру подобие звездного поля. 

Увеличивая Size Jitter и Opacity Jitter кисти 

становятся более разнообразными.
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Паттерны Добавьте изюминку в ваш дизайн с 

помощью паттерна или текстуры. В 

Photoshop это очень просто: сначала 

нарисуйте квадратики которые равномерно 

повторяются, затем выделите их и зайдите в 

Edit > Define Pattern чтобы сохранить 

заготовку. Новый паттерн можно 

использовать с помощью панели Layer Style. 

Только не добавляйте его в самый верх 

слоев. Экспериментируйте с Blend Modes и 

Opacity чтобы менять взаимодействие 

паттерна с дизайном.

185Pixel Perfect Precision



Kuler Не хватает вдохновления на подбор цветов 

или палитр? Попробуйте Kuler. Это удобное 

расширение дает вам возможность смотреть 

и пробовать цветовые схемы, которые 

сгенерировали другие юзеры, а также 

создавать собственные. Прекрасно!
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Character Viewer В Mac OS X включено несколько удобных 

шрифтовых утилит которые появляются 

после активации Show Keyboard & Character 

Viewers в меню в System > Preferences > 

Keyboard. Первая — Character Viewer 

поможет вам найти знаки, которые редко 

используются. Для использования 

удостоверьтесь что ввод текста активен и 

сделайте даблклик на знак который хотите 

вставить. Если ничего не происходит значит 

выбранного знака нет в текущем шрифте.
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Keyboard Viewer Keyboard Viewer это младший брат Character 

Viewer. Более простое приложение которое 

показывает вам все буквы и символы 

доступные к вводу с клавиатуры. Нажатие 

на кнопку с вставляет соответствующий 

символ; зажмите модификатор Shift или 

Option чтобы увидеть другие доступные 

варианты. Хороший способ научиться 

вводить ударения и символы прямо с 

клавиатуры.
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Шорткаты Существует множество хоткеев для 

ускорения работы Path tool. Комбинируйте 

контуры двух существующих Shape слоев, 

выделяя их и нажимая Command + E. После 

рисования контура, соедините его с другим 

нажимая + (плюс) или держа Shift; и 

наоборот — (минус) или Option вырежет из 

шейпа. После рисования, добавляйте или 

убирайте новый контур из существующего 

выделяя его и нажимая - (минус) или + 

(плюс). 
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Если вы редактируете контур с помощью 

Direct Selection и не хотите случайно 

выделить другие Shape слои в документе, 

нажмите Q чтобы войти в Quick Mask Mode, 

которая изолирует слой над которым вы 

сейчас работаетете. Command + Shift + H 

скроет текущее выделение, удобно для 

просмотра текущего шейпа без контуров на 

границах. 

 
Контуры

Текст
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Photoshop CC включает в себя апдейт 

взаимодействия Direct Selection с путями, 

делая их редактирование проще. Теперь вы 

можете выбрать Select: All Layers в панели 

Options кликнуть и потянуть для выбора 

нескольких точек на нескольких слоях, что 

позволяет менять несколько шейпов за раз. 

Даблклик на пути изолирует его, а второй 

даблклик выходит из этого режима.

 
Контуры
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Во время создания выделения, зажмите 

пробел для того чтобы двигать точку 

выделения. 

Используйте квадратные скобки, [ и ], для 

изменения размера кисти. Shift + [ или ] 

увеличит или уменьшит жесткость кисти.Выделение и 
кисти
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Выберите слой и нажмите передний слэш / 

чтобы заблокировать его прозрачность. На 

Shape слоях это заблокирует положение. 

Скрывайте или раскрывайте все слои в 

документе нажимая и удерживая Command, 

и нажимая на иконку любого из 

раскрывающихся списков.Слои
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Чтобы скрыть все слои кроме одного 

зажмите клавишу Option и нажмите на 

иконку видимости. 

Чтобы показать или скрыть слои по 

очереди, зажмите и потяните курсор через 

необходимые иконки видимости. Слои
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Переключение между режимами экрана (F)  
Переключайтесь между нормальным, 

полноэкранным с таскбаром, и 

полноэкранным с черным фоном.

Hand tool (пробел) 
Временно активирует hand tool при зажатии: 

используется для движения по 

изображению.

Переключение между открытыми 

документами (Command + ) 
Работает как Command + Tab в Mac OS X, 

переключаясь между открытыми 

документами.

Цвет холста (Space + F) 
Переключается между цветами холста.

Переключение цветов (X) 
Меняет местами цвета заднего и переднего 

планов.

Цвета по умолчанию (D) 
Меняет цвет заднего и переднего планов на 

черный и белый

Смещение границы выделения (стрелочки) 
Смещает выделение на 1px.

Смещение границы выделения (Shift + 

стрелочки) 
Смещает выделение на 10px.

Смещение слоя (Command + стрелочки) 
Смещает выделенную область или слой на 

1px.

Смещение слоя 
(Command + Shift + стрелочки) 
Смещает выделенную область или слой на 

10px.

Выбрать все слои (Command + Option + A) 
Выбрать все слои из панели слоев.

Выбрать слой как выделение 
(Command + клик на миниатюру слоя) 
Выделение по форме слоя.

Включить/выключить layer mask  
(Shift + клик  на маске слоя)  
Включает и выключает маску.

Шорткаты 
Клавиатура
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View mask (Option + клик по маске ) 
Показывает маску слоя как отдельное 

изображение, которое может быть 

отредактировано как канал.

Загрузить маску как выделение 
(Command + клик по маске) 
Загружает маску как выделение.

Инвертировать выделение (Command + 

Shift + I) 
Инвертирует выделение: то что было 

выделено становиться не выделенным и 

наоборот.

Убрать выделение (Command + D) 
Убирает текущее выделение.

Вернуть выделение (Command + Shift + D) 
Возвращает последнее выделение.

Дублировать слой (Command + J) 
Дублирует выделенный слой.

Изменить прозрачность слоя (цифры 1–0) 
Изменяет прозрачность слоя с шагом в 10%.

Переключение между режимами 

наложения 
(Shift + + (плюс) or − (минус)) 
Переключает режимы наложения.
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Шорткаты 
клавиатуры и 
меню

Станьте мастером Photoshop, создавая 

кастомные клавиатурные шорткаты с 

помощью диалога Edit > Keyboard Shortcuts. 

На скриншоте выше вы можете увидеть 

несколько новых шорткатов для Align > 

Vertical Centers и Align > Horizontal Centers, 

которые часто используются в дизайне 

интерфейсов. Будет не лишним отключить 

Command + Q, чтобы уберечь себя от 

случайного выключения Photoshop.
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ILLUSTRATOR



Вступление Illustrator используется когда  векторные 

способности Photoshop не подходят для 

задания. Мы используем Illustrator для 

создания сложных шэйпов, которые затем 

обрабатываются в Photoshop. Таким 

образом они сохраняют изменчивость, а мы 

имеем доступ к широкому набору эффектов.
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Цветовые 
настройки 
Illustrator

Необходимо правильно настроить цветовые 

профили Illustrator. К примеру, вы можете 

захотеть добавить цвет для векторных 

набросков, которые соответствуют дизайну 

в Photoshop. Зайдите в Edit > Color Settings 

(аналогично Photoshop), удостоверьтесь что 

Working Space > RGB выставлен на Monitor 

RGB а в Display and Color Management 

Policies > RGB выключен.
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Настройки В Illusrator есть несколько настроек, которые 

можно изменить для улучшения пиксельной 

четкости. Первая — выставить увеличение с 

клавиатуры равное 1px, чтобы клавиши 

стрелочек слегка подталкивали шейпы и 

точки. Как только это сделано — идите в 

радел Units и выставьте General и Stroke в 

Pixels, это значит что все ваши размеры 

сейчас будут базироваться на пикселях. Так 

как цифровой шрифт все еще измеряется в 

Points, этот пункт мы не трогаем.
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Сетка Как и в Photoshop вам возможно будет 

удобно выставить сетку базирующуюся на 

10px gridlines с 10px разделителями. Эти 

настройки можно найти в Preferences > 

Guides & Grid.
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Привязка к сетке Да, вы угадали, не забудьте включить Snap 

to Grid и здесь. Расположение аналогично 

Photoshop — меню View.
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Умные 
направляющие

Иногда хочется  взбунтоваться и разбить 

пиксельную сетку. В этих случаях Smart 

Guides предоставляют удобную 

альтернативную форму привязки (snapping). 

Anchor точка должна располагаться под 

углом в 45° градусов на кругу. Расположите 

прямоугольный треугольник под ней как на 

примере, включите Smart Guides и выберите 

Pen tool. Теперь можно очень точно 

привязаться к точке, где два объекта 

пересекаются и добавить туда anchor point.
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Точность Панель Transform — лучший друг 

пиксельного снайпера. С помощью него вы 

можете узнать насколько идеальны размер 

и позиционирование всего шейпа (верхняя 

линия) или отдельной точки (нижняя линия). 

Также, используя опцию link для W и H 

значений, любая трансформация одного из 

пространств сразу же исправит второе, с 

такой же пропорцией, сохраняя объект в 

пропорции.

Плохо Хорошо
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Выравнивание по 
пиксельной сетке

Встречайте главного злодея Illustrator! 

Убедитесь что Align New Objects to Pixel Grid 

выключена в меню панели Transform и для 

всех существующих шейпов Align to Pixel 

Grid не задействована (выберите Show 

Options в меню панели для показа этих 

настроек). При включении эта опция 

выравнивает объекты по основной 

пиксельной сетке, что звучит неплохо, но 

представьте как она начнет самостоятельно 

передвигать объекты при добавлении 

обводки (stroke).
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Pixel Preview Еще одно свойство к которому следует 

настороженно относиться. При включении 

View > Pixel Preview, не попиксельно четкие 

шейпы могут отображаться так, как будто 

они являются таковыми.

Pixel Preview On Pixel Preview Off
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Предпросмотр 
размытия

Никаких особых поводов для волнения по 

этом пункту, но иногда Illustrator рендерит 

шейп и  размывает углы даже при 

попиксельных размерах в окне Transform. 

Похоже что это баг самого софта. Хорошо 

что размытие не появляется когда шейп 

импортируется в Photoshop.
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Организация На самом деле не стоит придумывать имя 

каждому слою в Illustrator если вы просто 

используете его для рисования шейпов, но 

старайтесь хотя бы объединять всё в 

группы, а не раскидывать по пространству 

размером с футбольное поле.
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АППЕНДИКС



PPPatterns The PPP Extras включает библиотеку 

простых паттернов доступных в виде 

Photoshop presets (Patterns/PPPattern.pat) 

или pre-applied Effects (Patterns/

PPPattern.psd).
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